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MasterWorks III – Auto Digitizing Wizard 
 

You are in control when you use the Auto Digitizing Wizard.  It can be as easy as just clicking 
Next and Finish.  But there are also tools on each page of the wizard that let you edit the image 
so the wizard produces the embroidery pattern you envisioned.  Learn to size, and crop your 
image.  And see how to link a graphics editing program to your MasterWorks wizard and use 
that program to edit your artwork. 
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Scan into Wizard 

1. To view the wizards in your MasterWorks, left click the Tools  tab 

2. The four MasterWorks III wizards  are displayed on the ribbon at the 
top of the page. 

 If you rest the cursor on any of the icons for a moment, a tool tip with the name 
of the icon pops up. 

3. The four Wizards built into MasterWorks and MasterWorks III are: 

 Photo-stitch Wizard  

 A Cross-stitch Wizard  

 Auto-Digitizing Wizard  

 And Auto-artwork Wizard  
4. The quickest and easiest way to turn artwork into a stitch file is through the 

MasterWorks Auto Digitizing Wizard.   

 The Wizard analyzes artwork and automatically turns the artwork into a stitch 
file. 

 This class will cover how the process works and what you can do to take 
control of that process 

 We will also look at how you can edit the stitching in the resulting embroidery 
patterns. 

5. Left click the Auto Digitizing Wizard  
 

The first thing you will need to do is select a computer image to be used to create your 
embroidery  

1. There are three ways to get a picture into the wizard so it can be turned into an 
embroidery design. 

 Select Image  opens a browser box so a saved image can 

be selected. 
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 Acquire  is used to scan an image directly into the wizard 

 The last image used in the wizard will be shown to the right of the Acquire 

button  

 
Prepare to scan: 

1. Print a copy of “dots artwork for scanner” with a color printer 
2. Place the printed dots on the bed of the scanner face down. 

3. Open the Auto Digitizing Wizard  on the Tools tab 

4. Left click Acquire  and Twain box will open 

 A Twain device is a device that can be plugged into the USB port of the 
computer and used to import pictures into the computer 

 Common Twain devices would be scanners, and digital cameras 

5. Left click Select Source  and a list of the Twain devices plugged into 
your computer will open. 

 Note that while your camera will appear on the source list if it is plugged into 
the computer and turned on 

 MasterWorks III is not able to import pictures directly from the camera.   
(1) I tried it and it hung up and created a CTRL/ALT/DELETE 
moment. 
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 If you want to work with photos, import them into the computer and save them 

 Then you will be able to work with them in MasterWorks. 

6. Select the appropriate scanner and left click Select  
 

To scan the image: 

1. Left click Acquire Image  and the software for your scanner will 
open  

 The software for your scanner may be different from mine, and this class will 
not address how to use different scanners. 

 In my scanner program, left clicking on the Preview button causes the 
scanner to show me a picture of what will be scanned. 

 I then click on the Finish button to actually complete the scan 
2. When the scan is complete, you will see a browser box open so you can save the 

scan. 
3. Save the scanned image  

 Navigate to the folder where your scan will be saved 
o The location where the file will be saved is shown in the window at the 

top of the browser box 

 In the File Name box, type the name of your picture (dots image) 

4. Left click Save  and the scanner program will close.   

 You will be back at the opening screen of the Auto Digitizer and your scanned 
image will be shown as the selected file at the right of Acquire. 

5. Left click Next  and the Auto Digitizer – Image Transformations screen 
opens 

 A preview of the design is 
shown on the right 

 The area covered with 
diagonal grey lines is the 
area that will be included in 
the embroidery design the 
wizard creates. 

6. If needed, left click and drag to 
move the cropping handles at 
the edge of the grey area to 
eliminate as much of the white 
background as possible without 
losing any of the dots. 
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Now that you have eliminated the empty white space around the dots, you can set the size for 
the embroidery design 

1. The size is always given in millimeters in the wizards 
2. It is easy to do the math to convert from millimeters to inches  

 It is the same math you do in your head when you make change for a dollar. 

 There are 25.4 millimeters in an inch, so for every 25¢ you have an inch.   
3. For an embroidery design that is five inches wide change the width to 125. 

 The height is automatically adjusted to keep the image proportional. 

4. Left click Next  three times. 

5. Left click Finish  

6. Left click the Home tab  

7. Left click to turn on Draw 3D  and see the pattern as it will stitch. 

Editing the Design 
 Even though the embroidery design has been created with the wizard, you will be able to edit 
the dots. 

1. All of the dots are filled with the same standard fill pattern. 

 You may want to add some interest and texture to the design by changing 
some of the fill effects. 

2.  Left click to select the color yellow in the Sequence View  

3. Left click to open the Pattern window  in the 
Properties box  

4. Select the fill called Thatched Basket  

5. Left click Apply  

 And the texture of the stitching in the yellow dots is changed  
 

The pink dots were changed to a Radial Column . 
1. Left click to select the color pink in the Sequence View  
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2. Left click Apply Stitches  to open the menu 

3. Select Radial  

4. And the pink dots now look like little puff balls  
 

Both the color and stitch effect were changed on the green dots. 
1. Left click to select the color green in the Sequence View 

2. Left click on an Avocado Green  color chip  in the Color Palette 

3. Left click Apply Stitches  to open the menu 

4. Select a Satin  outline stitch 

5. In the Properties box change the stitch width to 2.0  

6. Left click Apply  

7. And the green dots are changed to green satin stitched rings  
 

The large blue dots were changed to a Fancy Fill 
1. Select the blue Color in the Sequence View 

2. Left click Apply Stitches  to open the menu 

3. Left click Fancy Fill   

4. Open the Pattern window  and select a fill 
pattern.  

 The sample was changed to Carved 56  
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o The fill used on the sample is not available in MasterWorks Lite, but you 
could use Coil 1 or any other Fancy fill that you like. 
 

A straight stitch border was added to the some of the dots to make them pop. 
1. No outline was added to the olive green rings or to the pink puff balls 
2. Left click to select the yellow dots in the Sequence View 

3. Hold down the Control key  on your keyboard and left click to select the blue 
dots 

4. Right click and select Copy  from the right click menu 

5. Right click and select Paste  from the right click menu 

6. Change the color to Black by left clicking on a black color chip  in the Color 
Palette 

7. Left click Apply Stitches  to open the menu 

8. Left click Run  
9. Adjust the stitch settings in the Properties box:  

 Change the stitch length to 2.0  

 Change the stitch to a Double Run in the Type Window 

. 

10. Left click Apply  
11. Save the pattern and stitch 
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Select Image & Tolerance Value 

1. Open a New Page  on the Quick Access tool bar 

2. Left click the Tools tab  on the ribbon at the top of the page 

3. Select the Auto-Digitizing Wizard   

4. Left click Select Image , and the Open Image box opens. 
5. Select Flowers.jpg from the Artwork folder.  

 C:\Designer’s Gallery\MasterWorksIII\Artwork\Flowers.jpg 

6. Left click Open   

7. Left click Next  

8. Change the height to 100mm  

 Note that when the height is changed, the width is 

automatically adjusted  

9. Left click Next  twice. 
 

The Auto Digitizer - Vectorize screen opens 
1. The wizard has traced the elements of the picture. 
2. Some detail is missing in the tulip 
3. The Tolerance value slide can be used to control how the wizard interprets and traces 

the image. 

 The Tolerance slide controls how the colors in the image are traced 

 Moving the slide to the to the right toward the end labeled More will cause the 
wizard to combine the colors more as it traces similar colors in the artwork 

4. To try this, left click and drag to move the Tolerance Value slide toward More 

 In order to see the effect of this, you must left click Update Outlines 

 

5. Left click Update outlines  

 Once you left click Update Outlines, the image is re-traced 
using the new settings and the results are displayed in the 
preview on the right 

6. And on the flowers image, things look worse instead of better! 
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Since there are only two directions to move the slide, if the image looks worse, simply move the 
slide in the other direction. 

1. Left click and drag to move the Tolerance Value slide to the left toward the end 

labeled Less   

2. Left click Update outlines  
3. And the colors in the image will be combined less.   

 This is what needs to happen with the two shades of peach in 
the tulip 

 Now the two shades of peach have been traced as separate 
areas 

4. Left click Next   

5. Left click Finish  

 The Wizard has analyzed the design and turned it into an embroidery design. 

6. Left click the Home tab  

7. Left click to turn on Draw 3D  and see the pattern as it will stitch. 

Edit the Flowers 
Auto digitizing wizards in some programs create a “take it or leave it” embroidery pattern.  The 
auto digitizing wizard in MasterWorks creates an embroidery design that can be edited. 
 
Change colors 

1. Left click to select the leaves  in the 
Sequence View  
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2. Change the leaves to a different shade of green by left clicking on the desired color 

chip  in the Color Palette 
 

Change stitch direction 

1. Left click to select the daisy petals  in the 
Sequence View 

2. Left click on the small black arrow at the bottom of the Zoom tool  to open the 
zoom menu 

3. Left click To Selection  in the menu to zoom in on the daisy petals 
4. Left click in the background of the page so nothing is selected 
5. Left click to select a daisy petal with the stitches running the length of the petal 

instead of across the width of the petal 

6. Left click the Reform tool  
7. The two black dots with a string between them represent the stitch direction. 
8. Left click and drag the dots so the stitches will run across the width of the petal 

9. Left click Apply  in the Properties box 
10. Repeat to change the stitch direction on each petal that has stitches that do not run 

across the petal 
 

Change the stitch effect of a selected area 

1. Left click Zoom to Fit  

2. Left click Select  
3. Left click to select the blue vase 

 You have a choice of either left clicking on the blue vase on the design page or 
left clicking to select the blue vase in the Sequence View 

4. Left click Apply Stitches  

5. Left click Fancy Fill  and the stitches in the blue vase are changed 
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6. If desired, open the Pattern window  in the 
Properties box and select a different fancy fill.  

 The fancy fill called   was used on the 
sample. 

 

Re-Use Last Edited Image  
We clicked through the wizard pretty quickly, and it created an embroidery design for us with 
very little effort. But one of the best things about MasterWorks is that although it is easy to use, 
it also has sophisticated tools that give us a great deal of control of the process if we chose to 
use them.  
So let’s go back and look at each screen of the Wizard in detail. 

1. Left click the Preferences tab   

2. Left click Preferences  

3. Select the Environment tab  in the Preferences box 
4. Open the Image Editing Program window   

 This is where you can select the graphics editing program that you would like 
to link to your copy of MasterWorks III 

 The graphics editing programs installed in your computer will be shown in the 
list 

o MS Paint is used in this class, but you can use any image editing 
program that you find comfortable 

 If the program you want to use is not in the list: 
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o You can select Other Program and a Choose Image Editor box opens.   
o Open the Look in window and you can access the files in your computer 

to select your preferred program. 

2. For this class select MS Paint   

3. Left click OK  
 

To begin creating a new design 

1. Left click New Page  on the Quick Access tool bar. 

2. Left click the Tools tab  

3. Select the Auto-Digitizing Wizard  to open the Wizard. 
 

We used Acquire  to scan the dots, and we clicked on Select Image 

 to find the Flowers file, but remember there three choices here. 
 

1. The last image used in the wizard is shown in the window on the right 

 

2. Left click Next   without selecting a new artwork file and the flowers image 
will be used 

 The Auto Digitizer - Image Transformations screen opens 

 The flowers that we selected the last time we opened the wizard appear. 

 

Image Transformations  
There are several changes that can be applied to the image in the Image Transformations 
screen 
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1. At the bottom of each box in the wizard is a Back  button that will return you 
to the previous screen in the wizard 

 So you could change your mind and back up to the previous screen and select 
a different image  

2. You can re-size the image. 

 The image will be traced by the wizard and the final embroidery will be the size 
of the image that was traced 

3. Left click and drag across the height to select it. 

4. Type in 100   

 The width  will automatically change to stay in proportion 
to the new height. 

 If you choose to change the width of the design, then the height will be 
automatically adjusted. 

5. Left click Reset size  and the size of the image is returned to the 
original setting. 

 

6. Left click Transform  to open a menu of options that allow you to flip 
and rotate your artwork. 

 
7. The image can also be cropped. 

 The area of the image with grey lines will be processed by the Wizard. 

 Change the grey area by clicking and dragging the black handles on the outline 
of the grey area. 

 Moving the corner handles will change both the width and the height of the 
selected area 

 Moving the handles on the sides will change only the width of the selected area 

 Moving the handles on the top or bottom will change 
only the height of the selected area 

7. Change the selected area so only the tulip is inside the grey 
area 
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8. Left click on Select All  and the grey cropping area will return to the 
original setting with the whole image inside the grey area. 

 
Now that you have experimented with the various settings 

1. Change the height to 100  
2. Move the bottom and the right side of the selection area so the tulip, stem and leaf are 

selected  

3. Left click Next  

Color Reduction 

The Autodigitizer Wizard - Color Reduction screen opens with only the cropped tulip. 

1. This screen allows you to control the colors that will be used in the embroidery design. 

 The colors the wizard found in the image are shown on the left. 

 Below the window with the color chips, the number of colors 

 is shown. 

 The arrows next to the number of colors can be used to increase or decrease 
the number of colors in the design. 
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2. Left click on the arrow that points down to reduce the number of colors to 5 

  

3. Left click Show/Hide Preview  below the image in the right 
side of the box to see the change. 

 The last color in the design has been combined with the color most like it 

 So the edge of the pale yellow daisy petal has been combined with the white 
background color 

4. To make further changes, you will need to left click the Show/Hide Preview 

  button again.   

 While in preview the only functions on the screen that can be used are the 
zoom tools. 

 When the preview is turned off the deleted color reappears because the 

change will not actually happen until we click on Next  to go to the 
next screen of the Wizard. 

5. Left click the arrow that points down to reduce the number of colors to 4 

  and another color is eliminated from the end of the color list  

 Now the second peach color in the tulip has been removed. 

6.  Left click on Show/Hide Preview   

 The peach area that was removed has been combined with 
the color most like it  

 So now the tulip is all one shade of peach 
7. To make further changes left click Show/Hide Preview 

 again.   

8. Left click Reset  to return to the original colors. 

 If you change the number of colors in the window, the last color in the design 
will be the one that is removed 

 And the area filled by the color that was removed will be filled instead with the 
remaining color that is most similar to the color removed 
 

The Delete  key can be used to remove specific colors from the image. 

1. Left click on Color 2   to select that color 

2. Left click Delete  

3. Left click Show/Hide Preview  to see the 
results of the change. 
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 Color 2 has been combined with the closest color match and the tulip is now 
one color and it is the remaining darker peach 

 And the yellow daisy petal is still visible 

4. Left click Show/Hide Preview  to turn off the preview 

5. Left click Reset  to return to the original six colors 
 

Use the Zoom tools built into the Wizard to look at the detail in your design or to hand pick the 

colors to be included in the design.  

1. Left click Zoom  

 Each time you left click on the zoom icon, you will be zoomed in closer to the 
image 

2. Left click the Pan tool  

 If you move your cursor so it is on the tulip, the cursor turns into a hand  

 You can left click and drag to move the image to see any area. 
3. Use the Pan tool to move the tulip so you can see both shades of pink and the green. 

4. Change the number of colors in the design to 1  

 You will not be able to change the number of colors to 0 because the 
background color cannot ever be deleted 

5. Left click the Eyedropper  to pick up the colors you want to include in your image.  

 Left click with the Eyedropper  once on the light pink, once on the dark pink 
and once on the green. 

 Each of the three colors is added to the color palette. 

6. Left click Zoom to fit  to return to viewing the whole image. 

7. Left click Show/Hide Preview  to confirm 
that the colors you have selected are going to work 

 The pale yellow of the daisy petals has been combined with the 
white background which is fine. 

 But the blue vase has been combined with the green of the 
stem and leaves which is not what we wanted. 
 

It is important to realize that when colors are deleted in the in the wizard, they are not removed.  
Rather, they are combined with the colors that remain in the image. 

 
1. This is a good thing since it means we won’t accidentally create an embroidery design 

with an empty hole where there should have been stitches. 
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If editing the colors in the wizard doesn’t get you the image you had hoped for, the solution is to 
change the picture.  And we can do that by using our link to a graphics editing program. 

Edit Image  can be used when the image needs more done to it. 

1. Left click Show Hide Preview  to turn the preview off so we 
can continue editing 

2. Left click Reset  

3. Left click Edit Image  

 We have linked MasterWorks to MS Paint in Program Preferences, so clicking 

on Edit Image opens the tulip in Paint. 
 

Use your graphics editing program to eliminate the unwanted colors 
1. Select white from the color palette   

2. Left click the Fill with Color  paint bucket 
3. Left click on the pale yellow daisy petal at the right edge of the image 

 The paint bucket fills the yellow area with white to match the background of the 
image 

4. Left click on the blue of the vase 

 The paint bucket fills the blue area with white to match the background of the 
image 
 

There is a little bit of the green stem from the daisy in the lower right corner of the image 
1. Left click on that little bit of green stem 

 And the paint bucket fills it with white to match the background of the image 
 

Now that the unwanted colors have been eliminated we can close Paint. 

1. Left click on the Close Program  in the upper right corner to close the Paint 
program 

 A box opens to prompt you to save the changes you made. 
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2. Left click Save   

 The newly edited image appears in the Wizard. 

3. Left click Next  

Vectorize 

The Autodigitizer Wizard – Vectorize screen opens.  This screen shows you the outlines that the 
Wizard has created from your artwork. 

1. The outlines on the tulip have lost the detail of the second color, so an adjustment will 
be needed.   

2. Move the Tolerance Value slide  toward less 

3. Left click Update Outlines  and now you should have two colors 
of peach in the tulip 

 
This screen also gives you the option to “Fill background color area with stitches”  

 The default is to not place stitches in the background area. 
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 If you want the background color to be sewn, then left click to place a check mark in 
the box by  left clicking Fill background color area with stitches  

 If you choose to fill the background area with stitches, you will have a rectangular 
embroidery design with the white background stitched with fill stitches as shown in the 
picture below. 
 

4. The white box  to the left of the Fill 
background color option is showing the color that the Wizard believes is the background 
color. 

 If the Wizard has selected the wrong color as the background it can be 
changed. 

5. Left click the Eyedropper  
6. Place your cursor over the green in the tulip picture and left click.   
7. The box has changed from white to green 

  
 All of the white area of the picture would be filled with stitches, and the green 

area would not have any stitches. 
8. Place your cursor over the white area of the picture and left click.   

 The background color is set back to white. 

9. Left click Next  
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Judgment 
The Autodigitizer Wizard Judgment screen opens. 
 

1. The Sequencing Order allows you to select the logic that will be used in to decide the 
order that the colors in the design will be sewn. 

 If you select Minimize Color Change, the 
number of spool changes will be minimized, 
but there may be more jump stitches in the 
design. 

 If you select Minimize Jump, then jump 
stitches will be avoided if possible, but there 
may be more spool changes. 

 Note that you can change the sewing order 
after you click on Finish if you are not happy 
with the choices made by the Wizard. 
 

The Lock Stitch and Trim settings are designed for commercial embroidery machines 
 
Baby Lock embroidery machines, including all of the Baby Lock multi needle embroidery 
machines will lock the stitching for each color change no matter what settings are specified 
here. 
 
And all Baby Lock embroidery machines will automatically trim if the machine is able to trim no 
matter what settings are specified here. 
 

1. Left click Finish  

2. Left click the Home tab  

3. Left click Draw 3D  

 It is easy to create embroidery designs using the 
Autodigitizer Wizard! 

Use the Tulip 
1. Select All Items  at the top of the Sequence View 

2. Right click and select Group  from the right click menu 

3. Right click and select Copy  from the right click menu 

4. Right click and select Paste  from the right click menu 
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Flip and move the new tulip so you have two side-by-side tulips 

1. Left click the Modify tab  

2. Left click Flip Horizontal  
3. Left click and drag the flipped tulip to the right of the first 

tulip. 
 
Add a basket to hold your flowers. 

1. Left click the Home tab  

2. Left click Artwork  to open the menu 

3. Select Custom Shape   

 And a box opens displaying the custom shapes that are available 

4. Left click to select the custom shape called Basket  
 

Adjust the basket size and position 

1. Left click Zoom to Fit  
2. Select the basket in the Sequence View 
3. Left click and drag the corner handle of the selection box 

around the basket to make it large enough for the tulips to fit 
under the handle. 

4. Left click and drag the basket so the tulips are centered in the 
opening. 

5. Left click Zoom to Fit  
 
Turn the basket into an appliqué 

1. Select the basket in the Sequence View 

2. Left click Apply Stitches  to open the menu 

3. Left click to select Applique  

 And now the tulips are in a blue applique basket 
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Adjust the settings in the Properties box 

1. Change the Stitch length to 2.0  

2. Change the Appliqué width to 2.5  

3. Left click Apply  
4. Select the outside outline of the basket 

5. Select  a light gold color   in the Color Palette 

 A box will open asking which of the three colors that 
make up the appliqué should be changed. 

6. Select Color 3  
7. Select the inside outline of the basket handle 

8. Select  the same light gold color  in the Color Palette 

 A box will open asking which of the three colors that make up the appliqué 
should be changed. 

 Select Color 3  
 

Preview your appliqué with fabric.   
Note that this feature is only available in MasterWorks II and MasterWorks III 
 

1. The basket is separated into two different objects in the Sequence View.   

 The outside of the basket is one object, and the inside of the handle is a 
separate object. 

 You will want to combine the two pieces to preview the look of the appliqué and 
then break them apart again before you save the design and sew it. 

 If you don’t combine the two pieces the preview will place fabric in the opening 
under the handle. 

2. Select both sections of the appliqué basket. 

 Left click on the handle outline in the Sequence View 

 Hold down the Control key  on your keyboard. 

 Left click on the basket outline in the Sequence View so both pieces are 
selected 

3. Right click and select Combine  in the right click menu. 
4. In the Properties Box, open the  Appliqué Fabric window 

 

5. Select Fabric04  
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6. Left click Apply  

 Your basket will be shown as it will appear with fabric! 
 

If you want to see your own fabric previewed in the appliqué 
1. Scan your fabric and save the image. 
2. Left click on the button to the right of the Appliqué Fabric window

 

3. Locate your saved fabric scan, select it and left click Open  

  Your scanned fabric will be shown in the appliqué and it will be 
added to your list of appliqué fabrics in MasterWorks  

 So the only thing you need to do to add your own fabrics to your 
MasterWorks fabric list is to use it! 
 

Before you save the design 
1. Open the Appliqué Fabric list and select None  

2. Left click Apply  
3. Note that there is a jump stitch from the outside of the basket to 

the inside of the handle.   

 This happened when we combined the two lines. 
4. Select the basket in the Sequence View 

5. Right click and select Break Apart  from the right click 
menu to return your appliqué to two separate pieces and 
eliminate the jump. 

In-the-Hoop Applique 
It is easy to stitch in the hoop applique patterns.  As you can see in the photo below, the tulips 
were stitched first so the stems would be under to basket applique. 
To sew an appliqué in the embroidery hoop: 

1. Hoop the background fabric and stabilizer 
2. Sew the first straight stitch step on the background fabric 
3. Place the appliqué fabric over the basket outline, making 

sure that the appliqué fabric covers the entire stitched 
outline.  

 You can use a sticky spray if you want to keep the 
fabric from shifting. 
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4. Stitch the second straight stitch through both the appliqué and the background fabric. 

5. Remove the hoop from the machine, but do not take the fabric out of the hoop. 
6. Carefully trim the fabric around the outside of the clover. 

 If you hold the scissors flat as you see in the picture you will not accidentally 
cut the background fabric.   

7. If there is an inside hole to trim, as there is under the handle of the basket, use a 
straight pin to lift the appliqué fabric so you can insert the tip of your scissors to trim 
the appliqué fabric without cutting the background fabric.  
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8. Place the hoop back on the machine and stitch the satin stitch.  

  The raw edge will be covered and the appliqué is finished! 

 
If you are planning to sew your applique on a Baby Lock multi needle machine: 

1. Baby Lock multi needle machines are going to react to the color changes of the 
appliqué design differently than the single needle sewing and embroidery machine 
does. 

2. A sewing and embroidery machine with just one needle sees a color change as an 
instruction to stop sewing so the machine can be re-threaded with a new color. 

3. The multi needle machines see a color change as an instruction to change to a new 
needle and keep sewing. 
 

It is easy to take care of this at the machine when you are setting up to embroider your appliqué 
design. 

1. Touch the Color Palette  symbol on the touch screen of the machine 
2. Select the second color of the appliqué 

3. Touch the icon with a hand  

 The hand will appear above the spool in the color list  

 The hand tells the machine “Before you sew this color you must “Stop”. 

 This will allow you to place the appliqué fabric over the first outline that has 
already been sewn. 

4. Select the third color of the appliqué and touch the icon with a hand . 

 The hand will appear above the spool in the color list and the machine has 
been told to stop before sewing this color also. 
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Using Framed Artwork  
When creating designs from artwork with a frame, you will need to use the background options 
to control the resulting embroidery. 

1. The wizard determines what the color of the background is by looking at what color is 
at the edge of the image 

2. If you have an image with a colored frame around the background, then the wizard is 
going to pick up the wrong color as the background color in the image 

 
Try it with the artwork image shown in the picture above. 

1. Left click New  on the Quick Access tool bar to open a New Page 

2. Left click the Tools tab  on the ribbon at the top of the page 

3. Select the Auto-Digitizing Wizard   

4. Left click Select Image   

 And the Open Image box opens. 
5. Select “Bird with frame.WMF”    

 Downloaded along with the class handout 

6. Left click Open   

7. Left click Next  

8. Change the height to 100mm  

9. Left click Next  twice. 
 

On the Vectorize screen, note that the rectangle for the 
background color shows that the background color is purple.  

10. Left click Next  and Finish  
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11. Left click the Home tab  

12. Left click 3D  to see what the design will look like when it is stitched. 

 The purple frame was not stitched because MasterWorks treated it a 
background, and the white background was filled with stitches. 

 There are also holes in the purple flowers. 

 The same shade of purple from the frame was also in the flowers and was not 
stitched 

 
Try it again, and see how easy it is to fix the problem 

1. Left click New  on the Quick Access tool bar to open a new page 

2. Left click the Tools tab  

3. Left click to select the Auto-Digitizing Wizard   

4. “Bird with frame.WMF” is already selected  

5. Left click Next  

6. Change the height to 100mm  

7. Left click Next   twice. 
8. On the Vectorize screen, change the background 

color to white 

 Left click the Eyedropper  

 Move the cursor onto the picture and it 
turns into an eyedropper. 

 Left click with the tip of the eyedropper 
in the white background of the picture  

 The background rectangle turns white. 
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 Now the color that will not be stitched is white 

 And the purple in the frame and in the flowers will be stitched 

9. Left click Next  and Finish  

10. Left click the Home tab   

11. Left click Draw 3D   to see what the design will 
look like when it is stitched. 

 The white background was not stitched 
because MasterWorks treated it a background, 
and the purple frame was filled with stitches. 

 

Edit the Design 
It is not unusual to want to do a little editing on designs that have been created in the Wizard.   

1. You may want to change colors,  
2. Change the type of fill stitches that were used,  
3. Or change the stitching order in order to make the embroidery look exactly how you 

visualized it when you chose the artwork. 
 

On this design the lighter purple areas were filled with a combination of Column and Fill stitches. 
To change all of the light purple to the same type of fill: 

1. Select the light  purple in the Sequence View 

2. Left click Apply Stitches  

3. Left click to select Auto   

 The Auto Column tool will change all of the selected areas to a Column stitch 
and automatically place the stitch inclinations on each embroidery object. 

 Both the flower petals and the frame look better when stitched in a satin 
column  

 You may see the warning for satin stitches that are too large. 
4. Close the warning box 
5. In the Properties box, open the Traveling Route window 

 
 This is a new feature in MasterWorks III  

 It controls where the traveling stitches will be stitched 

6. Change the Traveling Route to Along Middle  
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7. Left click Apply  
 

Change the stitch effect for the centers of the flowers 
1. Select the pale yellow of the flower centers in the Sequence View 

2. Left click Apply Stitches  

3. Left click Motif  
4. Open the Pattern window in the Properties box  

5. Select Candlewicking 04  

6. Left click Apply  

 The centers of these flowers are small enough that one motif stitch will fill the 
area! 
 

Change the beak of the bird.  The light yellow was also used in the bird’s beak, and a 
candlewick stitch may not be the best choice for that area 

1. Left click on the plus sign to the left of the light yellow in the Sequence View and 
the list of yellow areas is opened. 

2. Left click on each little yellow section of the design then look to see which part of the 
design is selected on the design page 

 As you select each yellow stitch object that area will be selected on the design 
page  

 This is the easiest way to figure out which of those little yellow sections is the 
beak on the bird 

3. When the selection box moves to the beak you will know that the correct area is 
selected 

4. When you have found and selected the beak. left click Apply Stitches  

5. Left click to select Auto  to change the beak to a satin stitch. 
6. Left click on the minus sign to the left of the yellow color in the Sequence View to 

close the list again. 
 

Change the sewing order 

1. Right click Light Blue bird body  in the Sequence View to open the right click 
menu 
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2. Left click Move   in the right click menu 

3. Slide sideways to select First   

4. Click and drag the light green  to sew before the dark green . 
5. Right click the yellow in the Sequence View to open the right click menu 

6. Left click Move  

7.  Slide sideways to select Last  

8. The bird looks much better after the sewing order of the colors is changed 

 The wizard used the same order in 
which the colors were drawn by the 
original artist. 

 But when you translate the image to 
thread, a different color order creates a 
much better look 
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Color Same as Background 

Sometimes you may have an image with the same color in the image and in the background.  If 
you select to not stitch the background color, then you will not have any stitches on that color 
within the image. 

1. The wizard is not able to distinguish that some of that color is background and some 
of the same color is part of the image 

2. You can easily edit the image so the background is a different color and solve the 
problem 

 
To try it using the swan image included with the class download  

1. Left click New  on the Quick Access tool bar to open a new design page 

2. Left click the Tools tab  

3. Left click Auto Digitizing  

 And the wizard is opened 

4. Left click Select Image  

 Navigate to the folder where the image is stored 
 

It may appear that the image is not in that file 
because the default is to look for Bitmap images and 
the swan is a Vector image 

1. Open the Files of Type window and select 
Vector images 

 And now that the computer is 
looking for vector images, any .wmf 
(window metafile), .emf 
(enhanced windows metafile), or 
.ai (Adobe Ilustrator) images in 
that folder will be visible so you 
can select them 

2. Select the file called swan.ai  

 

3. Left click Open  

4. Left click Next  in the wizard 
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The Image Transformation screen opens 

1. Change the height of the image to 100mm  

2. Left click Next  
 

The Color Reduction Screen opens 
1. Both the background of the image and the swan are white 

 If we do not sew the background color, there will be no stitching in the white 
area of the swan 

2. The fastest way to fix this is to change the color of the background area of the image 

3. Left click Edit Image  to open the swan picture in your graphics editing 
program 
 

If you are using Paint 

1. Left click the Magnifier icon   
2. Right click on the image to zoom out so you can see the whole picture 
3. Choose any color in the color palette at the top of the page that is not in the swan 

 There is no lime green in the swan, so that is a good color to use 

 Left click on the lime green color chip to select that color 

4. Left click to select the Fill with color  paint bucket 
5. Left click above the swan’s back to change the 

background color to lime green 
6. Left click below the swan’s neck to change that part of 

the background to lime green 
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7. Left click in the lower right corner of the picture to change the last little section of 
the background to lime green 

8. Close Paint by left clicking the X in the red box  in the upper right corner of the 
page 

9. A box opens to prompt you to save the image 

10. Left click Save  
11. And the swan is returned to the wizard 

 And now the background areas of the image are lime green 

 And the swan is still white 

 

12. Left click Next  
 

The Vectorize screen opens 
1. And the wizard has recognized that the 

background color of the image is lime 
green 

2. If there is no checkmark in Fill 
Background color area with stitches 

then the color that will not be stitched is 
the lime green shown in the box 
between the eyedropper and the Fill 
background box 
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3. The white areas of the swan will now not be affected by choosing to not sew the 
background color. 

4. Left click Next  and Finish  

Edit the Swan 

1. Left click the Home tab  

2. Left click Draw 3D  
3. Left click on the background area of the design page so nothing is selected 

 
Change the color of the stitches in the beak 

1. Left click to select the beak in the Sequence View 
2. Left click an orange color chip in the Color Palette to change the beak color 

 
Move the grey wing so it sews on top of the white swan body 

1. Left click to select the grey wing in the Sequence View 
2. Left click and drag to move the grey wing to the bottom of the list in the Sequence 

View so it will sew after the white swan 
 

Move the black outline so it will sew last 
1. Vector artwork is generally drawn by creating the outline first, so you will often find 

that when using .wmf, .emf, or .ai files you will need to move the outline to the end of 
the sewing order 

2. Left click to select the black outline in the Sequence View 
3. Left click and drag to move the black outline to the bottom of the list in the 

Sequence View 

 The outline will now be the last to sew and will sew after the grey wing that we 
moved previously 
 

Change the black to an outline stitch 
1. Left click on the plus sign to the left of the 

black outline and you will be able to see that 
the outline of the swan is a Column stitch and 
the eye is a fill stitch 

2. Left click to select the Column outline 

3. Left click Apply Stitches  

4. Left click Run (Motif)   
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5. Open the Motif window in the Properties box and select motif 229 

 

6. Change the Stitch Length to 1.5mm  

7. Left click Apply  

 And now the swan has a chain stitch outline 
 

Change the swan’s eye to a satin stitch 
1. Left click to select the Fill stitch eye in the Sequence View 

2. Left click Apply Stitches  

3. Left click Auto  

 And the eye is changed to a satin stitch instead of a flat fill stitch 
 

If you want to add just a little bit more personality, you could also use a fancy fill on the grey 
wing 

1. Left click to select the grey wing in the Sequence 
View 

2. Left click Apply Stitches  

3. Left click Fancy  
4. Open the Pattern window and select the desired 

pattern 

 The sample used the Geometric 26 

 
 

5. The Emboss Scale was set at 80%  
 

The wizard will do the work of tracing your artwork and filling it with flat fill stitches. 
 

The artistry of deciding what type of stitches will make the design pop and show your personality 
still belongs to you! 
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Companion Products for this Sew at Home Class 
 

  
MasterWorks III with HoopWorks EDG-MW3 
MasterWorks III Upgrade with HoopWorks EDG-MW3TU 
  
  
  
Embroidery Positioning Stickers BLSO-EPS 
Ginger 5” Curved Embroidery Scissors G-5C 
Ginger 4” Curved Embroidery Scissors G-4C 

Finishing Touch Bobbin Thread  
BBT-W (White) 
BBT-B (Black) 

Madeira Embroidery Thread, 40wt  
Embroidery needles 75/11 
Basic Embroidery Skills for Embroiderer’s Learning Guide Windows 8 SAHLG-BCSE8 
Sew@Home OnLine Classes (can be used for LIVE/Interactive or 
OnDemand/recorded classes) 

SAH 

 


